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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and conditions of this 

legal disclaimer before you read or use this document. If you have read or used this document, it 

shall be deemed as your total acceptance of this legal disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website or other Alibaba 

Cloud-authorized channels, and use this document for your own legal business activities only. 

The content of this document is considered confidential information of Alibaba Cloud. You shall

 strictly abide by the confidentiality obligations. No part of this document shall be disclosed or 

provided to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted, or disseminat

ed by any organization, company, or individual in any form or by any means without the prior 

written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades, adjustment

s, or other reasons. Alibaba Cloud reserves the right to modify the content of this document 

without notice and the updated versions of this document will be occasionally released through

 Alibaba Cloud-authorized channels. You shall pay attention to the version changes of this 

document as they occur and download and obtain the most up-to-date version of this document

 from Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud products and 

services. Alibaba Cloud provides the document in the context that Alibaba Cloud products and

 services are provided on an "as is", "with all faults" and "as available" basis. Alibaba Cloud 

makes every effort to provide relevant operational guidance based on existing technologies

. However, Alibaba Cloud hereby makes a clear statement that it in no way guarantees the 

accuracy, integrity, applicability, and reliability of the content of this document, either explicitly 

or implicitly. Alibaba Cloud shall not bear any liability for any errors or financial losses incurred

 by any organizations, companies, or individuals arising from their download, use, or trust in 

this document. Alibaba Cloud shall not, under any circumstances, bear responsibility for any

 indirect, consequential, exemplary, incidental, special, or punitive damages, including lost 

profits arising from the use or trust in this document, even if Alibaba Cloud has been notified of 

the possibility of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to works, products

, images, archives, information, materials, website architecture, website graphic layout, and 

webpage design, are intellectual property of Alibaba Cloud and/or its affiliates. This intellectu

al property includes, but is not limited to, trademark rights, patent rights, copyrights, and trade
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 secrets. No part of the Alibaba Cloud website, product programs, or content shall be used, 

modified, reproduced, publicly transmitted, changed, disseminated, distributed, or published

 without the prior written consent of Alibaba Cloud and/or its affiliates. The names owned by 

Alibaba Cloud shall not be used, published, or reproduced for marketing, advertising, promotion

, or other purposes without the prior written consent of Alibaba Cloud. The names owned by 

Alibaba Cloud include, but are not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other 

brands of Alibaba Cloud and/or its affiliates, which appear separately or in combination, as well

 as the auxiliary signs and patterns of the preceding brands, or anything similar to the company

 names, trade names, trademarks, product or service names, domain names, patterns, logos

, marks, signs, or special descriptions that third parties identify as Alibaba Cloud and/or its 

affiliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions

Table -1: Style conventions

Style Description Example

This warning information indicates a 
situation that will cause major system 
changes, faults, physical injuries, and 
other adverse results.

Danger:
Resetting will result in the loss of user
configuration data.

This warning information indicates a 
situation that may cause major system
 changes, faults, physical injuries, and 
other adverse results.

Warning:
Restarting will cause business
interruption. About 10 minutes are
required to restore business.

This indicates warning information, 
supplementary instructions, and other 
content that the user must understand.

Note:
Take the necessary precautions to
save exported data containing sensitive
information.

This indicates supplemental instructio
ns, best practices, tips, and other 
content that is good to know for the 
user.

Note:
You can use Ctrl + A to select all files.

> Multi-level menu cascade. Settings > Network > Set network type

Bold It is used for buttons, menus, page 
names, and other UI elements.

Click OK.

Courier 

font

It is used for commands. Run the cd /d C:/windows command
to enter the Windows system folder.

Italics It is used for parameters and variables. bae log list --instanceid

 Instance_ID

[] or [a|b] It indicates that it is a optional value, 
and only one item can be selected.

ipconfig [-all|-t]

{} or {a|b} It indicates that it is a required value, 
and only one item can be selected.

swich {stand | slave}



Quick BI User Guide /  Contents

II Issue: 20181217

Contents

Legal disclaimer........................................................................................I
Generic conventions................................................................................ I
1 Privilege control................................................................................... 1

1.1 Basic concepts of permission management.................................................................... 1
1.2 Share data objects in a workspace................................................................................. 2
1.3 Publish the data objects in a workspace......................................................................... 3
1.4 Share the data objects in the personal workspace..........................................................4
1.5 Publish the data objects in the personal workspace....................................................... 5
1.6 Data Portal menu permission settings.............................................................................6

2 Data modeling.......................................................................................8
2.1 Overview of data modeling.............................................................................................. 8
2.2 Data source management................................................................................................8

2.2.1 Data sources management overview................................................................. 8
2.2.2 List of data sources.......................................................................................... 10
2.2.3 Create cloud data sources................................................................................10
2.2.4 Create a data source from external database.................................................. 15
2.2.5 Upload local files...............................................................................................22
2.2.6 Edit data sources..............................................................................................25
2.2.7 Delete data sources..........................................................................................26
2.2.8 Synchronize data sources................................................................................ 26

2.3 Dataset management..................................................................................................... 27
2.3.1 Dataset overview...............................................................................................27
2.3.2 Create a dataset............................................................................................... 27
2.3.3 Edit a dataset....................................................................................................27
2.3.4 Analyze a dataset............................................................................................. 36
2.3.5 Rename datasets..............................................................................................36
2.3.6 Delete datasets................................................................................................. 36
2.3.7 Search for datasets...........................................................................................37
2.3.8 Create dataset folders...................................................................................... 37
2.3.9 Rename dataset folders....................................................................................37
2.3.10 Delete dataset folders.....................................................................................37

3 Create a report................................................................................... 38
3.1 Manage files................................................................................................................... 38
3.2 Workbook overview........................................................................................................ 39
3.3 Highlight pivot tables......................................................................................................41
3.4 Dashboard overview.......................................................................................................41
3.5 Dashboard basic operations.......................................................................................... 45

3.5.1 Basic dashboard operations............................................................................. 45
3.5.2 Switch datasets.................................................................................................47
3.5.3 Search for the dimensions field and the measures field...................................47



Quick BI User Guide /  Contents

Issue: 20181217 III

3.5.4 Configure a chart.............................................................................................. 47
3.5.5 Filter by fields................................................................................................... 49
3.5.6 Sort data........................................................................................................... 50
3.5.7 Associate multiple charts.................................................................................. 50
3.5.8 Common widgets.............................................................................................. 51
3.5.9 Standard mode................................................................................................. 54
3.5.10 Fullscreen mode..............................................................................................55

3.6 Create charts..................................................................................................................57
3.6.1 Line charts........................................................................................................ 57
3.6.2 Area charts........................................................................................................58
3.6.3 Bar charts..........................................................................................................60
3.6.4 Stripe charts......................................................................................................62
3.6.5 Pie charts.......................................................................................................... 64
3.6.6 Geo bubble charts............................................................................................ 65
3.6.7 Geomap.............................................................................................................66
3.6.8 Table................................................................................................................. 67
3.6.9 Gauge................................................................................................................68
3.6.10 Radar chart..................................................................................................... 70
3.6.11 Scatter chart....................................................................................................71
3.6.12 Funnel chart.................................................................................................... 72
3.6.13 Card chart....................................................................................................... 73
3.6.14 TreeMap.......................................................................................................... 74
3.6.15 Polar chart.......................................................................................................75
3.6.16 Word cloud......................................................................................................76
3.6.17 Tornado Chart.................................................................................................77
3.6.18 Hierarchy chart................................................................................................78
3.6.19 Conversion path..............................................................................................80
3.6.20 LBS thermal map............................................................................................ 81
3.6.21 LBS bubble map............................................................................................. 82
3.6.22 LBS flying line map.........................................................................................84
3.6.23 Pivot table....................................................................................................... 86
3.6.24 Progress bar................................................................................................... 87



Quick BI User Guide /  Contents

IV Issue: 20181217



Quick BI User Guide /  1 Privilege control

Issue: 20181217 1

1 Privilege control

1.1 Basic concepts of permission management
Permission management include data object management and row-level permission management.

Data objects include data sources, datasets, workbooks, dashboards, and portals. Data object 

management is classified based on the workspace types, which include the personal workspace 

and the workspace.

Row-level permission

You do not need to configure row-level permission for all fields in a dataset. Configure row-level 

permission for certain fields as needed.

Currently, for a single field, the maximum number of values that can be shown on the list is 500. If 

the number of values exceeds 500, you can add the excess values to the list manually.

You can find the All check box on the list. If you select the All check box (equivalent to selecting

all values of a field) for a member of the organization, then the member can access the dataset

without restriction from this field. You do not need to reselect the All check box after adding or

deleting values for this field.

Significant time for configuring permissions is saved for administrators through selecting the All 

check box.

Manage data objects in a workspace

Quick BI supports sharing and publishing data objects in a workspace.

Share data objects in a workspace

Quick BI supports sharing workbooks, dashboards, and portals . Shared data objects are read-

only for other Alibaba Cloud accounts and RAM users. Other Alibaba Cloud accounts and RAM

users do not have permission to modify, delete or save the data objects.

• Only the owner of the data object and the administrators of the workspaces have permissions 

to share the data object.

• If you clear the Works can be authorized checkbox for a workspace, then the data objects in 

this workspace cannot be shared.

• Currently, data objects can only be shared with Alibaba Cloud accounts and RAM users of the 

same organization.
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Members can access the data objects in the workspace that they belong to.

Data objects can be shared with members of the same organization. Authorized users can view

the shared data objects in their own personal workspaces.

Publish data objects in a workspace

Data objects that have been published can be accessed by everyone using the URLs. We 

recommend that you do not publish data objects that involve private business data.

Manage data objects in the personal workspace

Only the owner of a personal workspace has permission to perform operations on the data objects

.

Share data objects in the personal workspace

Quick BI supports sharing workbooks, dashboards, and portals . Shared data objects are read-

only for other Alibaba Cloud accounts and RAM users. Other Alibaba Cloud accounts and RAM

users do not have permissions to modify, delete or save the data objects.

• Only the owner of the data objects has permission to share them.

• Data objects can only be shared with users of Alibaba Cloud Quick BI.

Authorized users can view the shared data objects in their own personal workspaces.

Publish data objects in the personal workspace

Data objects that have been published can be accessed by everyone using the URLs. We 

recommend that you do not publish data objects that involve private business data.

1.2 Share data objects in a workspace
Quick BI supports sharing workbooks, dashboards, and portals in a workspace. Shared data

objects are read-only for other Alibaba Cloud accounts and RAM users. Other Alibaba Cloud

accounts and RAM users do not have permission to modify, delete or save the data objects.

Context

Only the owner of the data objects and administrators of the workspace have permission to share

 the data objects. Currently, data objects can only be shared with Alibaba Cloud accounts and 

RAM users within the same organization.

If the Works can be authorized check box is cleared for the workspace, then the data objects in 

this workspace cannot be shared.

Procedure
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1. Log on to the Quick BI console.

2. Select a workspace.

3. Click Dashboards to jump to the Dashboards page.

4. Select a dashboard and click the Share icon in the Actions column as shown in the following

figure.

5. Enter the nickname or user ID of the user that you want to authorize. Select an expiration date

as shown in the following figure.

6. Click Save to complete sharing the data objects.

1.3 Publish the data objects in a workspace
Data objects that have been published can be accessed by everyone using the URLs. We

recommend that you do not publish data objects that involve private business data.

Procedure

1. Log on to the Quick BI console.

2. Select a workspace.

3. Click the Dashboards icon to jump to the Dashboards page.

4. Select a dashboard, click the More icon, and click the Make Public icon.

5. Select an expiration date and click Make Public as shown in the following figure.
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Copy and paste the newly generated URL to the address bar in your browser. Then you can 

access the dashboard using this URL.

1.4 Share the data objects in the personal workspace
Only the owner of the data objects has permission to share them.

Context

For personal workspaces, Quick BI supports sharing workbooks, dashboards, and portals. Shared

data objects are read-only for other Alibaba Cloud accounts and RAM users. Other Alibaba Cloud

accounts and RAM users do not have permission to modify, delete or save the data objects.

Note:

To access the data objects shared by others, make sure that you have purchased the Quick BI

service using your Alibaba Cloud account and the Quick BI service has not expired.

Procedure

1. Log on to the Quick BI console.

2. Click the Dashboards icon to jump to the Dashboards page.
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3. Select a dashboard and click the Share icon in the Actions column as shown in the following

figure.

4. Enter the usernames of the user that you want to authorize and select an expiration date as

shown in the following figure.

5. Click Save to finish the authorization.

1.5 Publish the data objects in the personal workspace
Data objects that have been published can be accessed by everyone using the URLs. We

recommend that you do not publish data objects that involve private business data.

Procedure

1. Log on to the Quick BI console.

2. Click the Dashboards icon to jump to the Dashboards page.

3. Select a dashboard, click the More icon, and click the Make Public icon.

4. Select an expiration date as shown in the following figure.
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5. Click Make Public to complete publishing the data objects. Copy and paste the newly

generated URL to the address bar in your browser. Then you can access the dashboard using

this URL.

1.6 Data Portal menu permission settings
You can set menu permissions in workspaces for data portals.

Menu permissions can be authorized to user groups and users. To create a menu permission, 

follow these steps:

1. Log on to the Quick BI console.

2. Select the target workspace. If you need to create a workspace, see Create a workspace.

3. In the left-side navigation pane, click Portals.

4. Select the target portal, click the three dots icon, and then select Menu permissions. You can

also right-click the target portal.
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5. In the Menu authority management panel, set menu permissions, as shown in the following

figure:

Note:

You can select one of the following options for Only authorized to be visible:

• Yes, which indicates only authorized user groups and users have permission to read the 

menu.

• No, which indicates all user groups and users have permission to read the menu.

6. Click OK.
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2 Data modeling

2.1 Overview of data modeling
Data modeling is used to visualize data and allows you to quickly identify and extract information.

Furthermore, it helps you to make correct decisions based on the trend represented by the data.

The basic process of data modeling is shown in the following figure.

1. Add data sources: a required step. Operations on datasets, workbooks, dashboards, and

portals are all based on data sources. For more information about data sources, see Data

sources management overview.

2. Create datasets: a required step. You can create a dataset by using any one of the following

three methods:

• Tables in a data source: You can create dashboards and workbooks based on datasets. For

more information about operations on datasets, see Datasets management overview.

• Local files: You can only create datasets based on local files in Personal Workspace. You

can create datasets based on CSV files uploaded from your local disk. For more information

about operations on CSV files, see Upload local files.

• Custom SQL queries: You can create datasets based on custom SQL queries in

MaxCompute. For more information about operations on custom SQL queries, see SQL 

overview.

2.2 Data source management

2.2.1 Data sources management overview
Quick BI supports the following types of data sources:

Cloud data sources:

• MaxCompute

• MySQL

• SQL Server

• Analytic DB

• HybridDB for MySQL

• HybridDB for PostgreSQL released

https://www.alibabacloud.com/help/doc-detail/27860.htm?spm=a2c63.p38356.a3.4.64c91d9a38fP3C
https://www.alibabacloud.com/help/doc-detail/27860.htm?spm=a2c63.p38356.a3.4.64c91d9a38fP3C
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• PostgreSQL

• PPAS

• Hive (Quick BI Pro)

External database data sources

• MySQL

• SQL Server

• Oracle

• PostgreSQL

• Hive (Quick BI Pro)

• Vertica（Quick BI Pro）

• IBM DB2 LUW（Quick BI Pro）

Exploration space

• CSV file

• Local Excel files

• Data IDE

Uploaded local files are stored in the exploration space. The exploration space is a dedicated 

storage area of Quick BI, providing 1G space for each user currently.

When creating data sources, the Quick BI has the following requirements for the network type of

data sources.

1. The VPC RDS instance can access Quick BI by using an extranet domain name. MySQL and 

SQL Server instances can access Quick BI by using an intranet domain name, other VPC RDS

 instances can't access Quick BI by using an intranet domain name.

2. The instances in the classic network can access Quick BI by using an extranet domain name

and an intranet domain name. When you access Quick BI by using an extranet domain name,

you should set the IP address whitelist on the RDS. For more information, see Set whitelist.

3. Quick BI can be accessed by using the public network.

4. MySQL and SQL Server built on a VPC ECs instance can access quick Bi via the internal 

network domain name.

https://www.alibabacloud.com/help/doc-detail/26198.htm?spm=a2c63.p38356.a3.5.26854bd3feeGKO
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2.2.2 List of data sources
On the Data Sources page, you can manage all the data sources. You can perform operations,

such as create data sources, query data sources, edit data sources, and delete data

sources, on this page as shown in the following figure.

On the right side of this page, you can click a data source to display all the tables in this data 

source. You can create a dataset from any one of these tables.

2.2.3 Create cloud data sources
Operations on datasets, workbooks, dashboards, and portals are based on data sources. This

topic describes how to build a cloud data source.

Go to the data source creation page to create a cloud data source.

1. Log on to the Quick BI console.

2. Click Data Sources to go to the data source management page.

3. Click Create Data Source and select a data source.

4. Click the Cloud Database tab.

MaxCompute

1. Click the MaxCompute icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: You do not need to modify the default address. If you want to modify it,

see Access domains and data centers.

Note:

The database endpoint varies with region. For example, in a classic network,

the database endpoints of Hong Kong region and Singapore region are http://

service.cn-hongkong.maxcompute.aliyun-inc.com/api and http://service.ap-

southeast-1.maxcompute.aliyun-inc.com/api respectively. For more information, see 

Access domains and data centers.

• Project: The project name.

• Access ID: The AccessKey ID.

https://www.alibabacloud.com/help/doc-detail/34951.htm
https://www.alibabacloud.com/help/doc-detail/34951.htm
https://www.alibabacloud.com/help/doc-detail/34951.htm
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• Access Key: The AccessKey Secret.

Note:

The value of the Access Key must be valid. The corresponding account is that of the project

administrator or owner, or a common user who has permissions to list, select, and create

instances.

3. Click Test Connection.

Note:

If the connection works properly, a message indicating connection success will be displayed.

4. Click Add to add a data source.

After the data source is added, the Data Sources tab page is automatically displayed, and all

data tables under the data source are displayed in the right-side pane.

MaxCompute data sources are asynchronously loaded and updated. If you create a 

MaxCompute data source for the first time, wait up to five minutes for the data synchronization.

MySQL

Due to the limitations imposed by the whitelist policy of ApsaraDB for RDS, before adding an 

ApsaraDB for RDS data source, you must manually add related IP addresses to whitelists on the 

ApsaraDB for RDS console.

For more information about how to add and set a whitelist, see Set whitelists.

1. Click the MySQL icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Username: The username of the database.

• Password: The password of the database.

If you do not know the username or the password, contact your data warehouse administrator.

3. Click Test Connection.

https://www.alibabacloud.com/help/doc-detail/26198.htm?spm=a2c63.p38356.a3.1.4a0c1ce4v8Eznb
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4. Click Add to add a data source.

If a data source with the same configuration already exists, a prompt message will be displayed

. Do not add a data source repeatedly.

SQL Server

You can add a data source from RDS for SQL Server in a similar way you add a data source from

RDS for MySQL. The differences are that you need to add the configuration item schema for data

sources from ApsaraDB for RDS (SQL Server), and the default port number of the SQL server is 

1433.

1. Click the SQL Server icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Schema: dbo.

• Username: The username of the database.

• Password: The password of the database.

3. Click Test Connection.

4. Click Add to add a data source.

Analytic DB

1. Click the Analytic DB icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Access ID: The AccessKey ID.

• Access Key: The AccessKey Secret.
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3. Click Test Connection.

4. Click Add to add a data source.

HybridDB for MySQL

You can add a data source from HybridDB for MySQL in a similar way you add a data source from

 RDS for MySQL.

1. Click the HybridDB for MySQL icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The default value is 3306.

• Database: The name of the database.

• Username: The username of the database.

• Password: The password of the database.

3. Click Test Connection.

4. Click Add to add a data source.

HybirdDB for PostgreSQL

You can add a data source from HybridDB for PostgreSQL in a similar way you add a data source 

from RDS for SQL Server. The default port is the port specific to HybridDB for PostgreSQL.

1. Click the HybridDB for PostgreSQL icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Schema: public.

• Username: The username of the database.

• Password: The password of the database.

3. Click Test Connection.



Quick BI User Guide /  2 Data modeling

14 Issue: 20181217

4. Click Add to add a data source.

PostgreSQL

1. Click the PostgreSQL icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Schema: public.

• Username: The username of the database.

• Password: The password of the database.

3. Click Test Connection.

4. Click Add to add a data source.

PPAS

You can add a data source from RDS for PPAS in a similar way you add a data source from 

HybridDB for PostgreSQL.

1. Click the PPAS icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Schema: public.

• Username: The username of the database.

• Password: The password of the database.

3. Click Test Connection.

4. Click Add to add a data source.
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Hive (for Quick BI Professional)

If you have purchased Quick BI Professional, you can add a Hive data source.

1. Click the Hive icon.

2. Specify the parameters required for data source connection as follows:

• Name: The display name in the data source list.

• Database Endpoint: The host name or IP address.

• Port: The port number.

• Database: The name of the database.

• Username: The username of the database.

• Password: The password of the database.

3. Click Test Connection.

4. Click Add to add a data source.

2.2.4 Create a data source from external database
This section describes how to create a data source from external database.

MySQL

1. Log on to Quick BI console.

2. Click Data Sources. The data source management page is displayed.

3. ClickCreate data source > From External Database > MySQL

4. Enter the required data source connection information, as shown in the following figure.
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• Display name: list of data sources display name

• Database address: Just fill in the host name or IP address.

• Port: Default 3306

• Database: Connection database name

• User name: corresponding user name

• Password: The password of the database.

5. Click Test Connection to perform the data source connectivity test.

6. Click Add to complete the data source add.

You must enable the ECS firewall to enable external accesses to MySQL.

1. Run the following command to access the firewall configuration file:

vi /etc/sysconfig/iptables

2. Add the following command to the firewall configuration file.

-A RH-Firewall-1-INPUT -m state –state NEW -m tcp -p tcp –dport 3306
 -j
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            ACCEPT

3. After the configuration succeeds, restart iptable.

service iptables restart

SQL Server

1. Click SQL Server.

2. Enter the required data source connection information, as shown in the following figure.

• Display name: list of data sources display name

• Database address: Just fill in the host name or IP address.

• Port: Default 1433

• Database: Connection database name

• Schema: dbo

• User name: corresponding user name

• Password: The password of the database.

3. Click Test Connection to perform the data source connectivity test.
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4. Click Add to complete the data source add.

PostgreSQL

1. Click PostgreSQL.

2. Enter the required information for connecting to a data source.

• Display name: list of data sources display name

• Database address: Just fill in the host name or IP address.

• Port: Default 5432

• Database: The name of the database to be connected to.

• Schema: public

• User Name: The user name of the database.

• Password: The password of the database.

3. Click Test Connection to perform the data source connectivity test.

4. Click Add to complete the data source add.

Oracle

1. Click Oracle.

2. Enter the required data source connection information, as shown in the following figure.
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• Display name: list of data sources display name

• Database Address: Enter the host name or IP address.

• Port: Default 1521

• Database: Name of the database to be connected to.

• Schema: public

• User Name: The user name of the database.

• Password: The password of the database.

3. Click Test Connection to perform the data source connectivity test.

4. Click Add. The data source is added.

Hive (Quick BI Pro)

If you are using the Quick BI professional, you can add Hive data source.

1. Click Hive.

2. Enter the required data source connection information, as shown in the following figure.
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• Display name: list of data sources display name

• Database address: Just fill in the host name or IP address.

• Port: Just fill in the correct port number

• Database: Connection database name

• User name: Corresponding user name

• Password: Corresponding Password

3. If you need to accelerate your Hive data source, enter the following data source acceleration

information, as shown in the following figure.

• hiveMetastoreUri: The address of Hive metadata.

4. Click Connect tests to perform a data source connectivity test.

5. Click Add to complete the data source add.

Vertica（Quick BI Pro）

If you are using Quick BI professional, you can also add a Vertica data source.

1. Click Vertica.

2. Enter the required data source connection information, as shown in the following figure.
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• Display name: List of data sources display name

• Database address: Just fill in the host name or IP address.

• Port Number: Default 5433

• Database: The name of the database to be connected to.

• Schema: public

• User Name: The user name of the database.

• Password: The password of the database.

3. Click Test Connection to perform the data source connectivity test.

4. Click Add to complete the data source add.

IBM DB2 LUW（Quick BI Pro）

If you are using Quick BI professional, you can also add an IBM DB2 LUW data source.

1. Click IBM DB2 LUW.

2. Enter the required data source connection information, as shown in the following figure.
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• Display name: list of data sources display name

• Database address: Just fill in the host name or IP address.

• Port Number: Default 50000

• Database: Connection database name

• Schema: DB2INST1

• User name: Corresponding user name

• Password: The password of the database.

3. Click Test Connection to perform the data source connectivity test.

4. Click Add to complete the data source add.

2.2.5 Upload local files
You can upload local CSV files and Excel files (.xls and .xlsx files) to the explore space as a data 

source.

The explore space is a data source type that is used only in the personal workspace. Each user 

has 1 GB storage space.

In addition, you can import data sources from the Data IDE.

CSV file

CSV files in UTF-8 format are decoded without errors. CSV files in GBK or GB2312 format are 

automatically decoded, but the decoding may fail in some special cases.

If your CSV files cannot be decoded correctly, use text editors such as Notepad to convert the 

encoding of the files to UTF-8. Otherwise, the content of the uploaded files is shown as gibberish.
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1. Use Notepad to open a CSV file.

2. Choose File > Save As.

3. Click the drop-down arrow of Encoding.

4. Select UTF-8.

After you have changed the encoding, upload the CSV file to the explore space.

1. Log on to the Quick BI console.

2. Click Data Source to enter the Data Sources page.

3. ClickCreate Data Sources > Local Upload > CSV file.

4. Enter a display name for the file.

5. Click Select File to select a file to upload, as shown in the following figure.

6. Click OK to upload the file.

Excel file

When you upload Excel files, you need to select which sheet in each excel file to upload. To make

 the editing and maintenance more flexible, you can only select one sheet in one Excel file at a 

time.

1. ClickCreate Data Sources > Local Upload > EXCEL file.

2. Enter a display name for the file.

3. Click Select a file to select the file to upload, as shown in the following figure.

4. Click OK to complete uploading the file.

Data IDE

Note:

Only supports importing data sources from the China (Shanghai) region, and you must add your

account to the project.

1. ClickCreate Data Sources > Local Upload > Data IDE.

2. Select the data source from the list.

3. Click Import to complete the importing of the data source.
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Update table data according to the local data source

The local data source feature of Quick BI is designed to meet the analysis requirements for your 

changing and growing business.

After you have uploaded a file, new files are generated as the business grows. You can append 

the new files to the table corresponding to the previously uploaded file to analyze business data 

consistently over a long period of time.

The new file can be in a format different from the previously uploaded file. For example, if you 

have uploaded a CSV file, you can import data from a sheet in an Excel file. Make sure that the 

field names and the field types in the files to be uploaded are the same as those in the previously 

uploaded file.

1. Click Data Source to enter the Data Sources page.

2. Click Explore Space to enter the Explore Space page.

3. Select a file, and then click Update.

4. Click Append to upload the file that needs to be appended.

5. Click OK to append the data.

Delete the data of the table corresponding to a local data source

If a file that you have appended contains dirty data, which decreases the accuracy of the data, you

 can delete the file with dirty data that is corresponding to the table in the uploaded file list. The 

corresponding dashboard displays corrected data without any manual changes. Therefore, the 

analysis results of data are accurate at all times.

1. Click Data Source to enter the Data Sources page.

2. Click Explore Space to enter the Explore Space page.

3. Select a file, and then click Update.

4. Locate the file that needs to be deleted, and then click the Delete icon, as shown in the

following figure.

Example of local files

To help you learn to use local data source files, we provide a sample CSV file here: Sales data 

examples.

The structure of the sales data is shown in the following table.

http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/47483/cn_zh/1483006983645/company_sales_record_utf8.csv?spm=a2c63.p38356.a3.1.613841274yUUi1&file=company_sales_record_utf8.csv
http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/47483/cn_zh/1483006983645/company_sales_record_utf8.csv?spm=a2c63.p38356.a3.1.613841274yUUi1&file=company_sales_record_utf8.csv
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Field Field type Description

order_id varchar Order ID

report_date datetime Order date

customer_name varchar Customer name

order_level varchar Order grade

order_number double Order quantity

order_amt double Order amount

back_point double Discount

shipping_type varchar Shipping type

profit_amt double Profit amount

price double Unit price

shipping_cost double Shipping cost

area varchar Region

province varchar Province

city varchar City

product_type varchar Product type

product_sub_type varchar Product subtype

product_name varchar Product name

product_box varchar Product packing box

shipping_date datetime Shipping date

2.2.6 Edit data sources
On the Data Sources page, you can view all the data sources and edit them.

Procedure

1. Log on to the Quick BI console.

2. Click Data Sources to go to the Data Sources page.

3. Select a data source, and click the Edit icon.

4. After you edit the data source, click Save.
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2.2.7 Delete data sources
You can view all data sources and delete data sources on the Data Sources page.

Context

Note:

If you have created a dataset based on a data source, the data source cannot be deleted and the

system will display an error message if you delete the data source.

Procedure

1. Log on to the Quick BI console.

2. Click Data Sources to go to the Data Sources page.

3. Select a data source, and click the Delete icon.

2.2.8 Synchronize data sources
In the Personal Space of Quick BI, you can synchronize MaxCompute and MySQL data sources

to Exploration Space.

1. On the Data Sources page, click Import Data.

2. Select a MaxCompute data source or a MySQL data source.

Note:

• You must add the following IP addresses to the RDS whitelist before synchronizing the

MySQL data source.

11.193.158.0/24,11.193.162.0/24,47.74.161.0/24,47.74.162.0/24

• You must switch to a classic network to synchronize MySQL data sources. A VPC network 

does not support the synchronization of MySQL data sources.

• This function is a one-time synchronization. If the data source is updated, you must 

synchronize the data source again.
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2.3 Dataset management

2.3.1 Dataset overview
You can add or import a data source to create a dataset. For more information about how to add

and import a data source, see Create a cloud data source, Create a data source from external

database, and Upload local files.

After you create a dataset, you can create a dashboard to visualize the dataset. For more

information about how to create a dashboard, see Use dashboard to create charts.

On the Datasets page, you can perform operations on a selected dataset such as analyze, edit, 

and rename.

2.3.2 Create a dataset
Prerequisites

Ensure that data sources have been successfully added or uploaded before you create a dataset.

Context

For more information about how to add and import a data source, see Create a cloud data source,

Create a data source from external database, and Upload local files.

Procedure

1. Log on to the Quick BI console.

2. Click Data Source to enter the Data Sources page.

3. On the right side of this page, select a table.

4. Click Create Dataset next to the table as the following figure shows.

After you create a dataset, you are automatically directed to the Datasets page. The newly

created dataset is labeled with the New icon. This helps you quickly find the newly created

dataset.

2.3.3 Edit a dataset
You can edit a dataset based on the chart demonstration needs.

1. Log on to the Quick BI console.

2. Click Datasets. The dataset management page is displayed. 

3. Select a dataset and click its name. The dataset editing page is displayed.
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Fields in the dataset are automatically classified into dimensions and measurements. You can

edit the dimension and measurement fields based on your table creation requirements. After the

dataset is edited, you can save and refresh the edited data using Toolbar provided by the system.

Edit a dimension field

You can click the operation icon of a dimension field or right-click a dimension field to open 

the editing menu. For example, if you want to create a bubble or color map, you must set the 

dimension type to "Geographical Information". Otherwise, you cannot properly make the map.

1. Select a dimension field,  for example, order_level.

2. Right-click the selected field. The field editing menu is displayed, as shown in the following

figure.
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• Edit: To modify the display name and remarks of a dimension field.

• Duplicate Dimension: To quickly copy a dimension. Copy is automatically displayed for the

generated dimension.

• Hide in analysis: Hide related dimensions.

• Cancel all hidden: Cancel the hide for related dimensions.

• Delete: To delete a field.

• Create Calculated Field (Dimension): To create a dimension field and customize the 

calculation mode.

• Move To: To quickly include a dimension field in an existing level for drilling.

• Create Level: To quickly include a dimension field in a created level.

• Move Up/Move Down: To move a field. You can drag the field or right-click the field to move

 it.

• Convert to Measurement: To convert the current dimension field to a measurement field.



Quick BI User Guide /  2 Data modeling

30 Issue: 20181217

• Change Dimension Type: To switch a dimension field to the default, date, or geographical 

type.

Edit a measurement field

1. Select a measurement field, for example, order_number.

2. Right-click the selected field. The field editing menu is displayed, as shown in the following

figure.

• Edit: To modify the display name and remarks of a measurement field.

• Duplicate Measure: To quickly copy a measure. Copy is automatically displayed for the

generated measure.

• Hide in analysis: Hide related measures.

• Cancel all hidden: Cancel the hide for related measures.

• Delete: To delete a field.

• Create Calculated Field (Measurement): To create a measurement field and customize the 

calculation mode.

• Move To: To quickly include a measurement field in an existing folder.

• Move Up/Move Down: To move a field. You can drag the field or right-click the field to move

 it.

• Convert to Dimension: To convert the current measurement field to a dimension field.

• Number Format: To set the display format of a number.
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• Aggregations: You can select an aggregation mode, such as sum, max, or min, on the menu

.

• Change Measure Type: To switch a measure field to the default, date, or geographical type.

Toolbar

You can use the toolbar shown in the following figure to save, refresh, or synchronize datasets.

• Sync Table Schema: To combine new table fields added to an online physical table. This 

operation can be used when an online physical table is changed, for example, a field is added

. In this case, fields can be easily synchronized online. If a field of the online table is deleted or 

renamed, the corresponding dimension/measurement of the dataset is not deleted.

• Refresh Preview: To refresh and preview data of a dataset.  If you want to view the latest data 

in real time, save the dataset and then refresh data.

• Save: To save a dataset.

• Save As: To save the current dataset as a new one. This operation can be used to quickly copy

 a new dataset or back up a dataset.

Join tables

Note:

Professional edition supports Multi-Dataset type, and it only applies to the MaxCompute, MySQL,

and Oracle data source. Other editions don't support.

mysql Oracle

The Multi-Dataset type is not supported

The following two joining modes are supported.

• Inner Join

• Left outer join

If you have two data tables that are from the same dataset, you can click Join Table to join one

or multiple fields in the second table to the table that is currently edited. The joined table fields are

automatically added to the dimension and measurement areas of the first table as folders.

1. Click the Join Table icon. The data table joining page is displayed.
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2. Click + Table Join and add the data table to be joined.

3. Click the drop-down arrow of Dataset Field and select the dataset field to be joined.

4. Click the drop-down arrow of Join Type and select the join mode.
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5. Click the drop-down arrow of Associate dimension table name and select a joined table

name.
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6. Click the drop-down arrow of Join On and select a joined field.
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7. Click OK. The joined table is added.

8. Click the preview icon to switch to preview mode, as shown in the following figure.

9. Click Save to save the current dataset.

Joined table example

1. On the dataset management page, select company_sales_record1.

2. Click its name and enter the dataset editing page.

3. Click the Join Table icon. The joined table editing page is displayed.

4. Click + to open the associated model dialog box.

5. Click Dataset Field drop-down arrow to select an associated field.

6. Click the Join Type drop-down arrow to select a join type, such as left outer join.
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7. Click the drop-down arrow of Associate dimension table name and select an associated

dataset.

8. Click Join On drop-down arrow to select an associated field.

9. Click OK. The joined table is added.

10.Click Preview icon to preview the data.

11.Click Save to save the dataset.

2.3.4 Analyze a dataset
You can use workbooks to analyze datasets.

Workbooks

1. Log on to the Quick BI console. (Quick BI Pro or Quick BI Professional)

2. Select Workspace.

3. Click Workbooks to enter the Workbooks page as shown in the following figure.

4. Click Create Workbook to enter the Workbooks page as shown in the following figure.

For more information about workbook operations, see Example: Create workbooks.

2.3.5 Rename datasets
1. Log on to the Quick BI console.

2. Click Datasets to go to the Datasets page.

3. Select a dataset. Click More, and click Edit Properties.

4. Enter a new dataset name and click Save.

2.3.6 Delete datasets
Procedure

1. Log on to the Quick BI console.

2. Click Datasets to go to the dataset management page.

3. Locate a dataset, and click the Ellipsis icon. Alternatively, right-click the dataset.

4. Select Delete to delete the dataset.
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2.3.7 Search for datasets
Procedure

1. Log on to the Quick BI console.

2. Click Datasets to go to the dataset management page.

3. Enter a keyword in the search box, as shown in the following figure.

4. Click the Search icon to search for a dataset.

2.3.8 Create dataset folders
Procedure

1. Log on to the Quick BI console.

2. Click Datasets to go to the dataset management page.

3. Click Create Folder and enter the folder name.

4. Click OK to create a folder.

2.3.9 Rename dataset folders
Procedure

1. Log on to the Quick BI console.

2. Click Datasets to go to the dataset management page.

3. Locate a dataset folder. Click the Rename icon, or right-click the folder and select Rename.

4. Enter a new folder name, and click OK.

2.3.10 Delete dataset folders
Procedure

1. Log on to the Quick BI console.

2. Click Datasets to go to the Datasets page.

3. Select a dataset folder. Click the Delete icon, or right-click the dataset folder and select Delete.

4. Click OK to delete the current folder.
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3 Create a report

3.1 Manage files
Data portals are also called data applications. You can query and edit your own chart files.

Procedure

1. Log on to the Quick BI console.

2. Click Workspace > Workbooks to enter the Workbooks page.

3. Select and right-click a workbook, as shown in the following figure.

• Edit: Edit the workbook.

• Edit Properties: Edit the workbook name.

• Share: Share the workbook with other users in a specific period.

• Make Public: Allows visitors to access the workbook through a generated link without 

logging on to the system.

• Move: Move the workbook to another directory.

• Delete: Delete the workbook.

Note:

A shared workbook is read-only and cannot be edited.

4. Click Dashboards to enter the Dashboards page.

5. Select and right-click a dashboard, as shown in the following figure.
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• Edit: Edit the dashboard.

• Edit Properties: Edit the dashboard name.

• Share: Share the workbook with other users in a specific period.

• Make Public: Allows visitors to access the workbook through a generated link without 

logging on to the system.

• Move: Move the dashboard to another directory.

• Delete: Delete the dashboard.

6. Click Portals to enter the Portals page.

7. Select a portal, and right-click it, as shown in the following figure.

• Edit: Edit the portal.

• Edit Properties: Edit the portal name.

• Share: Share the workbook with other users in a specific period.

• Delete: Delete the portal.

3.2 Workbook overview
Common features

After accessing a workbook, you can Undo, Redo, Cut, Copy, and Paste data content. See the

following figure.
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Condition rules

By clicking Set Conditional Formatting on the toolbar, you can add rules for data results. For

example, you can highlight data within a certain range. See the following figure.

Add hyperlinks

The Workbook provides the Add Hyperlink icon, which helps you create more beautiful charts

with richer content. See the following figure.

Add drop-down lists

You can click Drop-Down List on the toolbar to add labels for data entries.

Note:

Multiple labels must be separated by commas (,).

Text format

The text format feature enables you to adjust text in charts. This feature supports the following 

operations:

• Set the font, color, and background of text.

• Set the size and style (such as bold, italic, underline, and strikethrough) of text.

• Set the format of cells (such as text alignment, text wrapping, indentation, and cell merging).

• Set the format of text (such as general, number, text, percentage, date, and custom settings).

Table attributes

The table attribute feature enables you to adjust table attributes. This feature supports the 

following operations:

• Insert rows, insert columns, delete rows, delete columns, autofit row height, and autofit column

 width.

• Group, ungroup, hide rows, hide columns, freeze rows, and freeze columns.

• Set borders.

• Sort, filter, and set table styles.
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3.3 Highlight pivot tables
You can use the highlight pivot table feature to show data in different pivot tables.

1. Open the workbook editing page

2. Click the Data Preview icon and select a dataset.

3. Double-click or drag the fields to the panel, and then click Update.

4. Click Highlight Pivot Table, and then select the area to show the data.

5. Double-click or drag the fields to the panel, and then click Update.

You can modify the display name for different pivot tables.

3.4 Dashboard overview
This section introduces basic concepts of the dashboard, including the types, application 

scenarios, and data elements of charts in the dashboard.

For more information about the basic operations on a dashboard, see #unique_46.

To learn how to create other types of charts, see #unique_47.

Dashboards use a more flexible tile layout to show interactions between data. A dashboard not 

only visualizes data but also supports data filtering and query and multiple data display modes to 

highlight the key fields of data.

In terms of data display, dashboards display data in a more intuitive and clearer way through 

the wizard and drag, drop, and click operations on fields. In terms of data analysis, dashboards 

improve interaction experience of users by friendly prompts.

The data display performance is also greatly improved. You can query dynamic data on the 

dashboard editing page.

Types and application scenarios of data charts

Different data needs to be displayed using different chart types. Currently, Quick BI supports 17 

types of data charts, including line charts, bar charts, bubble map, and funnel charts.

The following table lists the analysis type and common application scenarios of each type of chart.

Analysis type Description Scenario Applicable chart

Comparison Compare the 
differences between 
each value or display
 a simple comparison

Compare the sales/
income differences of
 different countries or 
regions.

Bar chart, radar chart
, funnel chart, table, 
polar chart, tornado 
chart, and word cloud
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Analysis type Description Scenario Applicable chart

 of measurements
 between different 
categories.

Percentage Display the 
percentage of a part or
 the ratio of a value to 
the whole.

Display which 
salesperson contribute
s the most to the total 
sales.

Pie chart, funnel chart
, gauge, and tree chart

Relation Display relationship 
between each value 
or compare multiple 
measurement values.

View the relativity 
between two values 
and display the affect 
of the first value on the
 second value.

Scatter chart, tree
 chart, card chart, 
hierarchy chart, and 
conversion chart

Trend Display the trend of a
 value (especially the
 trend changes with 
time (for example, by
 year, month, or day
) or the progress or 
possible modes of an 
indicator.

View the sales or 
income trend of a 
product in a period of 
time.

Line chart

Geographic chart Intuitively show the 
size and distribution of
 related data indicators
 in a country or region
 on a map.  The 
datasets used must 
contain geographical 
data.

View the income of
 each region in a 
country.

Geo bubble and geo

Data elements of a data chart

Each chart contains the Data, Style, and Advanced tabs, as shown in the following figure.

• The Data tab determines data displayed on the chart.

• The Style tab determines the chart appearance and displayed details.

• The More tab determines whether data is associated with multiple charts and whether to 

dynamically display interaction and comparison between data based on your needs.
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Each chart is differentiated from other charts by its core data elements. For example, the core 

element of a map is its geographic latitude. Otherwise, data cannot be displayed on the map.

The following table lists the core data elements of each type of chart.

Chart name Data elements Composition of data 

elements

Line chart Category axis and value axis The category axis has at 
least one dimension, and the
 value axis has at least one 
measurement.

Area map Category axis and value axis The category axis has at 
least one dimension, and the
 value axis has at least one 
measurement.

Bar chart Category axis and value axis The category axis has at 
least one dimension, and the
 value axis has at least one 
measurement.

Code Charts Category axis and value axis The category axis has at 
least one dimension, and the
 value axis has at least one 
measurement.

Pie Chart Slice label and slice angle Slice labels have only one 
dimension, and the dimension
 value is smaller than or equal 
to 12. The slice angle has only 
one measurement.

Geo bubble map Geographic region and bubble
 size

Geographic regions have 
only one dimension, which is
 the geographic latitude. The
 bubble size has one to five 
measurements.

Geo map Geographic region and color 
saturation

Geographic regions have only
 one dimension, which is the 
geographic latitude. The color
 saturation has one to five 
measurements.
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Chart name Data elements Composition of data 

elements

Table Row and column Rows have unlimited 
dimensions, and columns have
 unlimited measurements.

Gauge Pointer angle and tooltip A gauge has only one 
measurement.

Radar chart Branch label and branch length Branch labels have one to
 two dimensions, and the 
branch length has at least one 
measurement.

Scatter chart Color legend, X axis, and Y 
axis

Color legends have only one 
dimension, and the maximum 
number of dimension members
 is 1000. The X axis has one
 to three measurements, 
and the Y axis has only one 
measurement.

Funnel chart Funnel layer label and funnel 
layer width

Funnel layer labels have only 
one dimension, and the funnel
 layer width has only one 
measurement.

Card chart Panel label and panel indicator Panel labels have at most one
 dimension. Panel indicators 
have at least one and at most 
10 measurements.

Tree map Color block label and color 
block size

Color block labels have only
 one dimension, and the 
dimension value is smaller
 than or equal to 12. The 
color block size has only one 
measurement.

LBS map Geographic region and LBS 
bubble size

Geographic regions have only
 one dimension, which is the 
geographic latitude. The LBS
 bubble size has one to five 
measurements.

Polar chart Slice label and slice length Slice labels have only one 
dimension, and the dimension
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Chart name Data elements Composition of data 

elements

 value ranges from 3 to 12. 
The slice length has only one 
measurement.

Word cloud Word size and word label The word size has only one 
dimension, and word labels 
have only one measurement.

Tornado chart Comparison subject and 
comparison indicator

The comparison subject has
 only one dimension, and 
comparison indicators have at 
least one measurement.

Hierarchy chart Tree parent and child node 
label and tree parent and child 
node indicator

Tree parent and child node
 labels have at least two 
dimensions. Tree parent and 
child node indicators have at 
least one measurement.

Conversion chart Previous page, current page
, and next page; PV of the 
present, current, and next 
pages, UV of the present, 
current, and next pages, path
 conversion rate, and page 
bounce rate

Each data element has only 
one dimension or measuremen
t.

Progress bar Progress indication The Progress indication has 
one to five measurements.

Pivot table Row and column Rows have unlimited 
dimensions, and columns have
 unlimited measurements.

3.5 Dashboard basic operations

3.5.1 Basic dashboard operations
This topic describes how to go to the Dashboards page and perform basic dashboard operations.

For more information about dashboards, see #unique_50.

To learn how to create charts, see #unique_47.
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Go to the Dashboards page

Quick BI Quick BI Pro

1. Log on to the Quick BI console.

2. Click Workspace > Dashboards to go to the Dashboards page.

3. Click Create Dashboard > Standard to go to the dashboard editing page.

Quick BI Professional edition

1. Log on to the Quick BI console.

2. Click Workspace > Dashboards to go to the Dashboards page.

3. Hover your mouse cursor over Create Dashboard button and select a display mode. Click the

display mode, as shown in the following figure.

For more information about how to create standard dashboards, see Standard dashboards.

For more information about how to create full-screen dashboards, see Full-screen

dashboards.

Areas of a dashboard

You can perform basic dashboard operations in the following three areas.

• Dataset selection area

• Dashboard configuration area

• Dashboard display area

Dataset selection area

In the dataset selection area, you can switch from an existing dataset to another dataset. Based 

on the preset data types, the fields of the new dataset are displayed in the dimension list and the

 measure list. You can select dimension and measure fields based on the data elements in the 

chart.

Dashboard configuration area

In the dashboard configuration area, you can select a chart type, and edit the title, layout, and

 legend pattern of the chart. In Advanced Settings, you can relate multiple charts and display 

analysis results from multiple perspectives. You can filter data using Filters. You can also insert a 

filter bar to search any key metric in a chart.
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Dashboard display area

In the dashboard display area, you can drag and drop a chart to change its position as you like. 

You can also change the chart type based on your needs. For example, you can change a column

 chart to a geo bubble map. The system will display the missing or error elements based on the 

basic components of different charts. The dashboard provides a guide feature to help you learn 

how to create a dashboard.

3.5.2 Switch datasets
In the dataset selection area, you can select or switch datasets, and search for datasets by

dimension and measure fields.

1. Click the Dataset Switch icon.

2. In the drop-down list, select or search for the datasets that need to be analyzed, such as

company_sales_record.

If you cannot find the required dataset from the drop-down list, go back to the dataset 

management page and ensure that the dataset has been successfully created.

For more information about how to create datasets, see Create a dataset Create datasets.

3.5.3 Search for the dimensions field and the measures field
After you have selected the datasets, the system automatically separates fields into the dimension

 and measure areas.

You can enter a keyword in the search bar, and click the search icon. The system automatically 

searches for the fields that contain the keyword.

1. For example, enter a keyword called product in the search bar.

2. The fields that contain the keyword automatically appear in the list, as shown in the following

figure.

3.5.4 Configure a chart
You can select a chart in the configuration area of a dashboard. After you select a chart, you can 

configure this chart.
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You must ensure that you have selected a dataset on the Data tab before you create a chart. In 

addition, dimensions and measures are applicable.

For more information about dimensions and measures, see #unique_57.

1. After you click a chart icon, the selected chart appears in a dashboard.

You can switch a chart to other types by clicking Change chart type in the upper-right corner of

 the page.

2. On the Data tab, select the required dimensions and measures.

• Click the cross icon next to a field to remove this field from the Category Axis (Dimensions)

area.

• Click the triangle icon next to a field to display the values of this field in ascending or

descending order.

3. Select a field and drag this field to the Colors (Dimensions) area.

The selected field appears in a chart with the specified color. If you fail to drag a field, an error 

message occurs. You can follow the instruction on the message to add or remove dimensions 

and measures.

Take the product_type field as an example.

1. Drag the product_type field to the Colors (Dimensions) area, and then click Update.

2. Select Style > Series settings to change your color matching themes.

4. Select the time interval that data automatically refreshes on the Auto refresh list.

5. On the Style tab, you can change the visual format of a chart by setting options in General

config, Style, Layout, Axis, and Series settings.

You can change a unit by setting a number in the Unit area. You can only multiply the values of

a field by the number you set in the Unit area.

Assume that the previous unit is centimeter. If you want to display data in meters, you must

 divide the previous unit by 100. In the Unit area, you can enter 0.01 in this case. For a 

multiplication operation, you can enter 100.

6. On the Advanced tab, you can associate the current chart with other charts.
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You must ensure at least two charts are created in the display area of a dashboard before you 

associate charts.

3.5.5 Filter by fields
When you work with a large dataset, you can use the filter feature to view only specific types of 

data from the dataset.

You can filter data of the string, number, or date type.

Filter data in string type

You can filter municipalities from the province field using the filter feature.

Take filtering municipalities as an example.

1. Drag the province field to the Filter Bar area, as shown in the following figure.

2. Click the Set Filter icon, and set filtering criteria.

3. Select the required filtering criteria. For example, select Filter by Enumeration, as shown in

the following figure.

4. Manually enter the field names or select the city names from the list.

5. After you have specified the fields, click OK.

6. Click Update. The system automatically redraws the chart based on the filters.

Filter numerical data

You can specify filtering criteria in the filter. For example, you can specify the order number with a 

value between 50 thousand and 100 thousand. In this case, the chart displays data based on your

 specified range.

Take filtering profit amount as an example.

1. Drag the profit amount field to the Filter Bar area.

2. Click the Set Filter icon, and set filtering criteria.

3. Select the filters as needed, such as greater than, less than, or equal to, as shown in the

following figure.

4. After you have specified the fields, click OK.

5. Click Update. The system automatically redraws the chart based on the filters.
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Filter data in date type

You can use the filter feature to filter data in a specific date range. For example, you can filter the 

order amounts in the range from 2013 to 2015.

Note:

You can filter data in date type exact to seconds.

Take filtering order dates (year) as an example.

1. Drag the order date (year) field to the Filter Bar area. Click the Set Filter icon, and set

filtering criteria.

2. Select the filters as needed. For example, specify the Absolute Time with the range from 2013

to 2015, as shown in the following figure.

3. After you have specified the fields, click OK.

4. Click Update. The system automatically redraws the chart based on the filters.

3.5.6 Sort data
In the Data tab, you can sort the data based on the selected measures and dimensions. The chart

displays the data trend based on the sorted result.

Procedure

1. Select order_number, click the triangle icon next to the field, as shown in the following figure.

The upward triangle indicates ascending order, and the downward triangle indicates 

descending order.

2. Click Update.

3.5.7 Associate multiple charts

Note:

The association function is enabled only if the dashboard has at least two charts.

On the More tab in the dashboard configuration area, associate multiple charts by performing the

following steps.

1. Select a chart, such as a funnel chart.
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2. Click the More tab.

3. The More tab displays the available charts that can be associated with the selected funnel

chart, as shown in the following figure.

4. Select the same field as Source Field to associate this chart with the funnel chart.

If the selected field is different from the source field, the system displays an error message.

5. Select Preview > PC. To go to the preview page.

6. Click the field that selected in Source Field in the funnel chart, the associated table chart 

automatically displays other data.

7. Click Unlink in the upper-right corner of the funnel chart can make the table goes back to the

original status.

Note:

The Unlink function only restored the chart to its original condition.

3.5.8 Common widgets
The dashboard display area supports the following widgets.

• Filter Bar

• Text Area

• IFrame

• TAB

• Image

Filter Bar

You can select the Filter Bar to query data in one or multiple charts.

1. Double-click Filter Bar icon.

2. Select a dataset and query fields. See the following figure.

Currently, the Filter Bar supports Single-Dataset association and Multi-Dataset association.

Example of Single-Dataset

1. Select Single-Dataset and select charts that query fields can be applied. See the following

figure.
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2. Click Style to edit the Filter bar title.

3. Click Search to query data.

Example of Multi-Dataset

The Filter Bar can also associate data from different datasets. Make sure that the values of data 

members of association items are consistent. Otherwise, the association is invalid.

1. Select a chart, such as Table.

2. Drag or double-click the expected fields and then click Update.

3. Click Style tab to modify table label and its layout.  For example, set table lable as Overseas

Report.

4. Click dataset switch icon to switch to another dataset.

5. Select a chart, such as Table.

6. Drag or double-click the expected fields and then click Update.

7. Click Style tab to modify table label and its layout.  For example, set table lable as Domestic

Report.

8. Double-click Filter Bar and select dataset and expected fields.

9. Click Multi-Dataset and select associated items according to the field types.

10.Click Style tab and modify the filter bar label.

11.Click Search. The charts automatically update.

Query data based on days

1. On the Data tab, select a dataset and a query field, for example, report_date (day).

2. Select a chart, which is expected to be applied.

3. Click field in Filter Bar, and then the filtering tab is displayed on the right, as shown in the

following figure.

4. Select a date range, as shown in the following figure.

The detailed time range for a month is automatically displayed, as shown in the following figure.

5. Click Search to query the date.

Query data based on text
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1. On the Data tab, select a dataset and a query field, for example, Product_box.

2. Select a chart.

3. Click field in Filter Bar, then the text filtering tab is displayed on the right, as shown in the

following figure.

4. Click Enum. The system automatically loads all available options of Product_Box to the Filter

Bar.

5. Select an option from the Product_Box drop-down list, such as Paper Bag. See the following

figure.

6. Click Search. The chart automatically update.

Text area

You can enter fixed text in a text area and use the text as a report title.

1. Double-click Text Area.

2. Enter text in the text area based on your requirements.

IFrame

IFrame enables you to insert an expected webpage in a dashboard to query network data in real 

time or to browse the webpage or website related to the current data.

1. Double-click IFrame icon.

2. In the link area, enter a webpage address based on your needs or preferences.

Note:

Webpage addresses must start with https.

TAB

The TAB feature enables multiple charts to be displayed in different tabs.

1. Double-click TAB icon.

2. In the TAB editing menu, you can add or delete the number of tabs based on chart

requirements. See the following figure.
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3. Click a tab and insert a chart in it. For example, click the  TAB1, the color of TAB1 is marked as

 blue.

4. Double-click the expected chart type icon. A chart is automatically inserted in TAB.

5. Create the chart by following the chart creation process.

Image

1. Double-click Image icon.

2. Enter an image link.

3. Set a display style of image, as shown in the following figure.

3.5.9 Standard mode
In standard mode, you can perform the following operations in the display area of a dashboard.

• Change chart position

• View chart data

• Delete chart

• Change chart type

• Add to favorites

• Configure settings

If you are using a Quick BI dashboard for the first time, a wizard will appear in the display area to

 guide you through the dashboard features. Follow the instructions in the wizard to learn how to 

create a dashboard.

More

In the top-right corner, click More to perform the following operations on a chart.

• View Data: view the data of this chart.

• Export: export the data of this chart with the Excel format.

• Delete: delete the chart.

Change chart type

You can change the type of a chart that appears in the display area.

Select a chart in the display area of a dashboard. Then, in the top-right corner, click Change chart 

type to select a chart type you want to change to.
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1. Select a chart in the display area of a dashboard.

2. Click Change chart type as shown in the following figure. For example, you can change a pie

chart to a radar chart as shown in the following figure.

3. The chart changes to the new type.

If a chart fails to change types, it is because the data fields of the selected chart type do not match

 those of the current chart data. You must modify these fields manually to change the chart type.

You will be prompted to modify some fields based on the selected chart type. To change chart

 types, follow the instructions on the screen to add appropriate dimensions or measures to the 

corresponding area.

Add to favorites

At the top of the display area of a dashboard, click the star icon to collect the current dashboard.

Configure settings

Click Settings to download the current dashboard or show a watermark, as shown in the following

figure.

3.5.10 Fullscreen mode
In the fullscreen mode, you can perform the following operations in the display area of a 

dashboard.

• Change chart position

• Add a subscreen

• View chart data

• Delete chart

• Change chart type

• Configure settings

Change chart position

In fullscreen mode, a chart will be scaled to its maximum extent in the display area of a dashboard

. In addition, when multiple charts exist in a dashboard, click the arrow cross icon and hold down 

the left button, and then drag charts to change the arrangement as shown in the following figure.
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Add a subscreen

1. Click the plus icon in the lower-right corner as shown in the following figure.

2. In a subscreen, you can add a chart as shown in the following figure.

3. Click the dot icon to switch between subscreens as shown in the following figure.

4. Click the Delete icon to delete a subscreen as shown in the following figure.

View chart data

1. Select a chart.

2. Click the More icon in the upper-right corner of a chart.

3. Select View Data.

4. Click the Export button in the Data Info dialog box to download data to your local disk.

Delete chart

1. Select a chart.

2. Click the More icon in the top-right corner of a chart.

3. Select Delete.

Change chart type

1. Select a chart in the display area of a dashboard.

2. In the configuration area of a dashboard, click Change chart type.

3. Select a chart type that you want to change to.

A chart may fail to change types. This issue occurs when data fields of the selected chart type do

 not match those of the current chart data. You must modify these fields manually to change the 

chart type.

You are required to modify some data fields based on the selected chart type. To change chart 

types, follow the instructions on the screen to change corresponding dimensions and measures.
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Configure settings

Click Page setting to change the page scale, skin setting, theme, time interval to update data,

and the time interval of carousel set.

3.6 Create charts

3.6.1 Line charts
Assume that you have read #unique_50 and #unique_46. This section describes how to create a

line chart. If you want to edit a dataset or create a dataset, see Create a dataset.

A line chart displays information as a series of data points connected by straight line segments. 

You can use a line chart to analyze and visualize a trend in data over equal intervals of time. In 

addition, you can use a line chart to analyze the correlation between multiple groups of data that

 changes over time. For example, you can analyze the sales volume of a group of products or 

multiple groups of products that change over time to obtain a forecast of sales trends.

A line chart consists of the category axis and the value axis. The category axis appears as a 

horizontal axis and oriented to the right. You can only add dimensions to the category axis such

 as date, province, and product_type. The value axis appears as a vertical axis and oriented 

upwards. You must add measures to the value axis such as metrics for analyzing objects including

 order_amt.

In a dashboard, fields have been automatically sorted into dimensions and measures as shown in

the following figure. When you create a line chart, you can drag fields from the Dimensions list

and the Measures list to the corresponding category axis and value axis as required.

Precautions

Select at least one dimension on the category axis and select at least one measure on the value

axis. The Colors (Dimensions) area can take only one dimension at most.

Note:

You can add dimensions to the Colors (Dimensions) area when only one measure is added to

the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the Colors

(Dimensions) area.

The following scenario is based on the company_sales_record dataset.

Scenario: Visualize the number of orders and price for each product category.
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1. Log on to the Quick BI console.

2. Click Datasets to enter the Datasets page.

3. Click the Create Dashboard icon on the right side of the company_sales_record dataset.

4. Click the Line icon, a line chart appears in the display area of the dashboard.

5. Select required dimensions and measures.

On the Dimension list, drag product_type to the Category Axis (Dimensions) area. On the

Measures list, drag order_amt and price to the Value Axis (Measures) area in turn as shown

in the following figure.

Note:

You must ensure that you have changed the province field from the string type to the location

type. For more information about how to change data types of a dimension, see #unique_57.

6. On the Style tab, you can change some items such as the title, layout, legend, and axis format

of a chart.

Note:

For more information about the Style tab, see #unique_66.

7. Click Save to save the dashboard.

If you want to delete the current chart, click More in the upper-right corner of the chart and select

Delete to delete the current chart.

3.6.2 Area charts
Assume that you have read #unique_50 and #unique_46. This section describes how to create an

area chart. If you want to edit a dataset or create a dataset, see Create a dataset.

An area chart displays graphically quantitative data. You can use an area chart to analyze and 

visualize a trend in data over identical intervals of time. In addition, you can use an area chart to

 analyze the interactions between multiple groups of data that changes over time. For example

, you can analyze the sales volume of a group of products or multiple groups of products that 

change over time to obtain a forecast of sales trends.

An area chart consists of the category axis and the value axis. The category axis is depicted as

 horizontal and oriented to the right. You can only add dimensions to the category axis such as

 date, province, and product_type. The value axis is depicted as vertical and oriented upwards
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. You can only add measures to the value axis such as metrics for analyzing objects including 

order_amt.

In a dashboard, fields have been automatically grouped into dimensions and measures as the 

following figure shows. When you create a line chart, you can drag fields from the Dimensions list 

and the Measures list to the corresponding category axis and value axis as required.

Precautions

You can set at least one dimension for the category axis, and set at least one measure for the

value axis. The Colors field can take only one dimension.

Note:

You can add dimensions to the Colors (Dimensions) area when only one measure is added to

the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the Colors

(Dimensions) area.

The following scenario uses the company_sales_record dataset.

Scenario: Visualize the number of orders for each product type of each province.

1. Log on to the Quick BI console.

2. Click Datasets to enter the Datasets page.

3. Click the Create Dashboard icon next to the company_sales_record dataset.

4. Click the Area icon, an area chart appears in the display area of the dashboard.

5. Select required dimensions and measures.

On the Dimensions list, drag the province and product_type fields to the Category Axis

(Dimensions) area in turn. On the Measures list, drag the order_amt field to the Value Axis

(Measures) area as the following figure shows.

Note:

You must ensure that you have changed the province field from the string type to the location

type. For more information about how to change data types of a dimension, see #unique_57.

6. Drag the product_type field to the Colors (Dimensions) area and click Update.
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Note:

You can add dimensions to the Colors (Dimensions) area when only one measure is added

to the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the

Colors (Dimensions) area.

7. On the Style tab, you can change some items such as the title, layout, legend, and axis format

of a chart as the following figure shows.

Note:

For more information about the Style tab, see #unique_66.

• In General config, select Dark as the background color.

• In Style, select Secondary Y Axis.

• In Layout, select Right to show the legend.

• In Axis, enter province in the Axis title field.

• In Series settings, change the color of the Office field to orange.

After you complete the configuration, the chart is shown in the following figure.

8. Click Save to save the dashboard.

If you want to delete the current chart, click More in the upper-right corner of the chart and select

Delete.

3.6.3 Bar charts
Assume that you have read #unique_50 and #unique_46. This section describes how to create a

line chart. If you want to create a dataset or eidt a dataset, see Create a dataset.

A bar chart shows comparisons among discrete categories. You can use a bar chart to visualize 

data changes over a period of time or comparisons among discrete categories. For example, you 

can show the comparison of the traffic flow of vehicles over different periods of time at a crossing.

Like #unique_69, a bar chart consists of the category axis and the value axis.
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Precautions

You can set at least one dimension for the category axis such as province and product_type. In

addition, you can set at least one measure for the value axis such as order_amt and profit_amt.

The Colors (Dimensions) area can take only one dimension.

Note:

You can add dimensions to the Colors (Dimensions) area when only one measure is added to

the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the Colors

(Dimensions) area.

The following scenario is based on the company_sales_record dataset.

Scenario: Compare the shipping cost for different products of provinces of East China.

1. Log on to the Quick BI console.

2. Click Datasets to enter the Datasets page.

3. Click the Create Dashboard icon on the right side of the company_sales_record dataset.

4. Click the Bar icon, a bar chart appears in the display area of the dashboard.

5. On the dimensions list, drag area to the Filters area.

You can search for the East China area by using filters as shown in the following figure.

6. Click the Filter icon. Select Filter by Enumeration in the Set Filter dialog box that appears as

shown in the following figure.

7. Select East China and click OK.

8. Drag province and product_type to the Category Axis (Dimensions) area in turn.

Note:

You must ensure that you have changed the province field from the string type to the location

type.

9. On the Measures list, drag shipping_cost to the Value Axis (Measures) area.

10.Drag the product_type field to the Colors (Dimensions) area.

Note:
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You can add dimensions to the Colors (Dimensions) area when only one measure is added

to the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the

Colors (Dimensions) area.

11.Click Update to update the chart.

12.On the Style tab, you can change some items such as the title, layout, legend, and axis format

of a chart.

Note:

For more information about the Style tab, see #unique_66.

13.Click Save to save the dashboard.

If you want to delete the current chart, click More in the top-right corner of the chart and select

Delete.

3.6.4 Stripe charts
Assume that you have read #unique_50 and #unique_46. This section describes how to create a

stripe chart. If you want to edit a dataset or create a dataset, see Create a dataset.

A stripe chart shows comparisons between categories. You can use a stripe chart to visualize data

 changes over a period of time or comparisons between categories. For example, you can show 

the working progress of employees in a project group.

Like #unique_69, a stripe chart consists of the category axis and the value axis.

Precautions

You can set at least one dimension for the category axis such as province and product_type. In

addition, you can set at least one measure for the value axis such as order_amt and profit_amt.

The Colors (Dimensions) area can take only one dimension.

Note:

You can add dimensions to the Colors (Dimensions) area when only one measure is added to

the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the Colors

(Dimensions) area.

The following scenario uses the company_sales_record dataset.

Scenario: Compare shipping costs for various products of each municipality.

1. Log on to the Quick BI console.
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2. Click Datasets to enter the Datasets page.

3. Click Create Dashboard on the right side of the company_sales_record dataset.

4. Click the Stripe icon and then a stripe chart appears in the display area of a dashboard.

5. On the Dimensions list, drag city to the Filters area.

You can search for municipalities from cities by using filters as the following figure shows.

6. Click the Filter icon and select Filter by Enumeration in the dialog box that appears.

7. Select four municipalities from the list or enter the names of them manually, and click OK as

the following figure shows.

8. Drag the city and product_type fields to the Category Axis (Dimensions) area in turn.

Note:

You must ensure that you have changed the province field from the string type to the location

type.

9. On the Measures list, drag shipping_cost to the Value Axis (Measures) area.

10.Drag product_type to the Colors (Dimensions) area.

Note:

You can add dimensions to the Colors (Dimensions) area when only one measure is added

to the Value Axis (Measures) area. Otherwise, you are not allowed to add dimensions to the

Colors (Dimensions) area.

11.Click Update to update the chart.

12.On the Style tab, you can change some items such as the title, layout, legend, and axis format

of a chart as the following figure shows.

Note:

For more information about the Style tab, see #unique_66.

• In General config, select Dark as the background color.

• In Style, select Stacked.

• In Layout, select Top to show the legend.
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• In Axis, select Display scale on the X-Axis tab.

After you complete the configuration, the chart is shown in the following figure.

13.Click Save to save the dashboard.

If you want to delete the current chart, click More in the top-right corner of the chart and select

Delete to delete the current chart.

3.6.5 Pie charts
Assume that you have read #unique_50 and #unique_46. This section describes how to create a

line chart. If you want to edit a dataset or create a dataset, see Create a dataset.

A pie chart shows a series of values for items in a dimension. Each item shown in a pie chart has

 a unique color or texture. Each sector in a pie chart represents one item in the dimension. Sector

 size represents the proportion of the value for the selected measure that the item represents

 compared to the whole dimension. For example, you can show the expenditure of five social 

insurances and one housing fund in proportion to the total personal income or the sales volume of 

a certain automobile brand in proportion to the total sales volume of all the brands.

A pie chart consists of sectors. The label of a sector is determined by a dimension such as the 

area field and the product_type field. The degree of an angle is determined by a measure such as

 order_amt and profit_amt.

Precautions

You can set at least one dimension in which the number of different values is less than or equals

 to 12 for the Slice Label (Dimensions) area such as area and product_type. In addition, you can 

set at least one measure for the Arc Angle (Measures) area such as order_amt and profit_amt.

The following scenario uses the company_sales_record dataset.

Scenario: Compare shipping costs for various areas.

1. Log on to the Quick BI console.

2. Click Datasets to enter the Datasets page.

3. Click the Create Dashboard icon on the right side of the company_sales_record dataset.

4. Click the Pie icon, a pie chart appears in the display area of the dashboard.

5. On the Data tab, select required dimensions and measures.
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On the dimensions list, drag area to the Slice Label (Dimensions) area. On the Measures list,

drag shipping_cost to the Arc Angle (Measures) as shown in the following figure.

Note:

You must ensure that you have changed the province field from the string type to the location

type.

6. Click Update to update the chart.

7. On the Style tab, you can change some items such as the title, layout, legend, and axis format

of a chart.

8. Click Save to save the dashboard.

If you want to delete the current chart, click More in the upper-right corner of the chart and select

Delete.

3.6.6 Geo bubble charts
Assume that you have read #unique_50 and #unique_46. This section describes how to create a

line chart. If you want to edit a dataset or create a dataset, see Create a dataset.

A geo bubble chart is a map of a country or an area that is attached with bubbles to represent the 

amount of data. You can use a geo bubble chart to graphically display metrics for each country or 

area and the distribution of these countries or areas. For example, you can show the traffic flow of 

tourists for each tourist attraction or show the per capita income for each area.

A geo bubble chart consists of locations and bubbles of different sizes. Locations are determined

 by a dimension such as the province field and the size of bubbles are determined by a measure 

such as shipping_cost and order_amt.

Precautions

You can set up to one dimension and the dimension type must be geographic information, such as

 area, province, and city. In addition, the bubble size area can be set from one to five measures.

The following scenario uses the company_sales_record dataset.

Scenario: Compart the number of orders and the amount of profit for each province.

1. Log on to the Quick BI console.

2. Click Datasets to enter the Datasets page.
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3. Click the Create Dashboard icon on the right side of the company_sales_record dataset.

4. Click the Geo Bubble icon and a geo bubble chart appears in the display area of a dashboard.

5. On the Data tab, select the required dimensions and measures.

On the Dimensions list, drag province to the Location (Dimension) area. On the Measures list,

drag order_amt and profit_amt to the Bubble Size (Measures) area in turn as shown in the

following figure.

Note:

Ensure that you have changed the province field from the string type to the location type.

6. Click Update to update the chart.

7. On the Style tab, you can change some items such as the title, layout, and legend of a chart.

8. Click Save to save the dashboard.

If you want to delete the current chart, click More in the upper-right corner of the chart and select

Delete to delete the current chart.

3.6.7 Geomap
This section describes how to create a geomap. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

Similar to #unique_74, geomaps use the gradation of color to reflect data values and distribution.

A geomap is a geographical map with colors assigned to specific regions. Regions are determined

 by data dimensions, such as province. Colors are determined by data measures, such as order 

amount and profit amount.

Note

For each geomap, one dimension must be specified to determine the regions. This dimension 

must be about geographic information. One to five measures can be specified to determine the 

colors of regions.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the transportation costs, orders amounts, and profits across multiple 

areas

1. Log on to the Quick BI console.
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2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Geomap icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measures.

In the Dimensions list, select Area and add it to Location. In the Measures list, select Order

Amount, Profit Amount, and Transportation Cost, and add them to Color Scale, as shown in

the following figure:

Note:

Make sure you have changed the data type of Area from String to Location.

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title of the diagram, the legend, and the value range of

each color.

8. Click the Save icon to save the dashboard.

To delete the diagram, move the mouse to the upper-right corner and click Delete in the toolbar

that appears.

3.6.8 Table
This section describes how to create a table. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A table can be used to display the distribution and total of specific variables. One variable defines 

the values in the header row and the other variable defines the values in the header column. The 

intersections of rows and columns contain the results of calculations on the data, such as the sum

, average, maximum, minimum, or count of the data.

A table consists of rows and columns. Rows are determined by data dimensions, such as province

 and product type. Columns are determined by data measures, such as order quantity and profit 

amount.

Note

For each table, the numbers of dimensions and measures are unlimited.

The following scenario uses the company_sales_record dataset as an example.
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Scenario: Compare multiple types of products with different package designs, transporta

tion costs, order quantities, and profit amounts across multiple provinces

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the table icon and the corresponding legend is displayed.

5. Click the Data tab to select data dimensions and data measures.

In the Dimensions list, select province, Product_type, and Product_box, and add

them sequentially to Row. In the Measures list, select order_amt, shipping_cost, and

average_profit, and add them sequentially to Column, as shown in the following figure:

Note:

Make sure you have changed the data type of Province from String to Location.

6. Click Update to generate the table.

7. In the Style tab, you can change the title, layout, style, and rules of the table.

In the Rules section, you can change the style of the data so that viewers can quickly find

important data. For example, change the font color, add marks to specific data, or highlight

cells based on custom rules.

8. Click the Save icon to save the dashboard.

To delete the table, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.9 Gauge
This section describes how to create a gauge. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

Similar to the dashboard in your car, a gauge clearly displays the range of a metric. You can view

 the progress of the current task or if a metric will exceed its range. For example, you can use a 

gauge to show the inventory status of an item and replenish the item accordingly.

A gauge displays the value of a metric using a pointer that moves along a scale. The angle of the 

pointer is determined by a data measure, such as discount or profit amount.
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Note

For each gauge, one and only one measure must be specified to determine the angle of the 

pointer.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Use a gauge to display order amounts

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Gauge icon and the corresponding legend is displayed.

5. Click the Data tab to select the data measure.

Note:

The system automatically adjusts the angle of the pointer and the text displayed in the tooltip.

In the Measures list, select order_amt and add it to indicator angle area or tooltip area, as

shown in the following figure:

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title, layout, and tooltip of the diagram and hide the scale.

• General Configuration: Specify the main title of the diagram, the font color, and the 

background color.

• Layout: Specify whether to hide the legend.

• Color Ranges: Configure subranges.

• Series Setting: Specify the alias of the metric and the number of decimal places to keep for 

the metric value.

8. In the Color Ranges section, click Add to add a subrange and enter the start and end values

of this range.

For example, you can set the start value to 100 and end value to 1000. The title of the 

subrange can be set to Net Profit, as shown in the following figure:

9. Click Update and the subrange appears in the gauge.

10.Click the Save icon to save the dashboard.
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To delete the diagram, move the mouse to the upper-right corner and click Delete in the toolbar

that appears.

3.6.10 Radar chart
This section describes how to create a radar chart. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

Radar charts can be used to compare multiple variables under different metrics. You can easily 

understand the distribution of metrics across different variables. For example, you can use a radar

 chart to compare sales across multiple areas.

A radar chart consists of a sequence of radius labels with varying radius. Radius labels are 

determined by data dimensions, such as product type. Radius are determined by data measures, 

such as transportation cost.

Note

For each radar chart, one or two dimensions can be specified to determine radius labels. The 

specified dimensions must contain 3 to 12 variables. At least one measure must be specified to 

determine Radius.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities and order amounts across areas

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Radar icon and the corresponding legend is displayed.

5. Click the Data tab to select data dimensions and data measures.

In the Dimensions list, select area and add it to radius label. In the Measures list, select

order_number and order_amt, and add them sequentially to radius, as shown in the following

figure:

Note:

Make sure you have changed the data type of Area from String to Location.

6. Click Update to generate the chart.
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7. In the Style tab, you can change the title, layout, and legend of the chart as follows:

8. Click the Save icon to save the dashboard.

To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.11 Scatter chart
This section describes how to create a scatter chart. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

Scatter charts display the distribution and correlation of data.

Scatter charts use the X and Y axes to plot data points. The colors of data points are determined 

by data dimensions, such as product type. The X and Y axes are determined by data measures.

Notes

For each scatter chart, one dimension must be specified to determine the colors of data points. 

This dimension may contain up to 1,000 variables.

One to three data measures can be specified for the X axis.

One data measure can be specified for the Y axis.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the unit prices and order amounts of different products

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Scatter Chart icon and the corresponding information is displayed.

5. Click the Data tab to select the data dimension and data measures.

In the Dimensions list, select product_type and add it to Color. In the Measures list, select

price and order_number, and add them to the Y axis and X axis respectively, as shown in the

following figure:

6. Click Update to generate the chart.

7. In the Style tab, you can change the title, layout, and legend of the chart.

8. Click the Save icon to save the dashboard.
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To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.12 Funnel chart
This section describes how to create a funnel chart. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

Funnel charts are suitable for analyzing business processes that involve a sequence of activities

 and span a long period of time. By comparing the business data between different stages, you 

can easily identify potential problems in the business process. Funnel charts can be used to show

 the conversion rates between stages of the business process. For example, you can see the 

percentage of visitors who became paying customers in a funnel chart easily.

A funnel chart consists of a number of tiers with varying labels and widths. The labels of tiers 

are determined by data dimensions, such as area. The widths of tiers are determined by data 

measures, such as order amount.

Note

For each funnel chart, one and only one dimension must be specified to determine the labels of 

tiers. One and only one measure must be specified to determine the widths of tiers.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order amounts across multiple areas

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Funnel Chart icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measure.

In the Dimensions list, select area and add it to Tier Labels. In the Measures list, select

order_amt and add it to Tier Area, as shown in the following figure:

6. Click Update to generate the chart.

7. In the Style tab, you can change the title, layout, and legend of the chart.

• General Configuration: Specify the main title of the chart, the font color, and the background

 color.
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• Layout: Change the position of the legend.

• Measure: Change the style of the measure and specify the number of decimal places to 

keep for the value.

• Tier: Specify the color of tiers.

8. Click the Save icon to save the dashboard.

To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.13 Card chart
This section describes how to create a card chart. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A card chart displays business data or sales performance, which enables you to visually gain 

insight into the business environment and quickly make strategic adjustments to optimize sales 

processes. It offers an effective and direct solution to discover and fix problems.

A card chart consists of a sequence of cards with multiple labels and metrics. Labels are 

determined by data dimensions, such as area. Metrics are determined by data measures, such as

 order quantity and order amount.

Note

For each card chart, one and only one dimension must be specified to determine labels. 1 to 10 

measures can be specified to determine metrics.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities, order amounts, transportation costs, and profit 

amounts across multiple provinces

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Card Chart icon, and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measures.

In the Dimensions list, select province and add it to Card Labels. In the Measures list, select

order_number, order_amt, shipping_cost, and profit_amt, and add them to Card Metrics,

as shown in the following figure:
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Note:

Make sure you have changed the data type of Province from String to Location.

6. Click Update to generate the chart.

7. In the Style tab, you can change the title and style of the chart, and the number of cards in

each row.

• General Configuration: Specify the main title of the chart, the font color, and the background

 color.

• Card Setting: Specify the template and style of the card.

• Series Setting: Specify the alias of the metric and the number of decimal places to keep for 

the metric value.

8. Click the Save icon to save the dashboard.

To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.14 TreeMap
This section describes how to create a treemap. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

Treemaps can be used to compare the proportions between variables easily.

A treemap consists of nested rectangles of multiple different sizes and labels. The labels of 

rectangles are determined by data dimensions, such as package design. The sizes of rectangles 

are determined by data measures, such as transportation cost.

Note

For each treemap, one and only one dimension can be specified to determine the labels of 

rectangles. This dimension can have a maximum of 12 dimension values. One and only measure 

can be specified to determine the sizes of rectangles.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities of different products

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.
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3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the TreeMap icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measure.

In the Dimensions list, select Product_type and add it to Rectangle Label. In the Measures list,

select order_number and add it to Rectangle Size, as shown in the following figure:

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title and legend of the treemap.

8. Click the Save icon to save the dashboard.

To delete the diagram, move the mouse to the upper-right corner and click Delete in the toolbar

that appears.

3.6.15 Polar chart
This section describes how to create a polar chart. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A polar chart can be used to display data changes over time or compare metric values. It is 

suitable for enumeration. For example, compare data across different regions.

Similar to #unique_83, a polar chart consists of sectors of varying slice labels and arc radiuses.

Slice labels are determined by data dimensions, such as area and product type. Arc radiuses are

determined by data measures, such as order quantity and order amount.

Note

For each polar chart, one and only one dimension must be specified to determine slice labels. 

This dimension must contain 3 to 12 variables. One and only one measure must be specified to 

determine arc radiuses.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities across multiple areas

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Polar Chart icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measure.
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In the Dimensions list, select area and add it to Slice Label. In the Measures list, select

order_number and add it to Arc Radius, as shown in the following figure:

Note:

Make sure you have changed the data type of area from String to Location.

6. Click Update to generate the chart.

7. In the Style tab, you can change the title and legend of the chart, the style of the metric values.

8. Click the Save icon to save the dashboard.

To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.16 Word cloud
This section describes how to create a word cloud. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A word cloud displays the frequency of words clearly. It is suitable for creating user personas and 

user tags.

A word cloud consists of words of varying sizes. Labels are determined by data dimensions, such

 as customer name and product name. Metrics are determined by data measures, such as profit 

amount and unit price.

Note

For each word cloud, one and only one dimension must be specified to determine labels. One and

 only one measure must be specified to determine metrics.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities across different provinces

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Word Cloud icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measure.
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In the Dimensions list, select province and add it to Word. In the Measures list, select

order_number and add it to Word Size, as shown in the following figure:

Note:

Make sure you have changed the data type of Province from String to Location.

6. Click Update to generate the chart.

7. In the Style tab, you can change the title of the chart.

8. Click the Save icon to save the dashboard.

To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.

3.6.17 Tornado Chart
This section describes how to create a tornado chart. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A tornado chart is the combination of a tornado diagram and a funnel chart. Tornado diagrams can

 be used to compare different contrast indicators between two objects, for example, the income

 and education levels between residents in two cities. Funnel charts can be used to show the 

conversion rates between stages of the business process and are suitable for business process

 analysis. You can see the percentage of visitors who turned into paying customers in a funnel 

chart easily.

A tornado chart combines the features of tornado diagrams and funnel charts. For example, 

when you compare the percentage of the migrant population, employment rate, and commercial 

housing transactions in Beijing and Shanghai, if a conversion relation exists between two items, 

the tornado chart can show the difference between multiple contrast indicators, and also display 

the conversion rates between comparisons.

If no conversion relation exists, the diagram functions the same as a tornado diagram. If a 

conversion relation exists between two comparisons and only one contrast indicator is defined, the

 diagram functions the same as a funnel chart.

A tornado chart consists of a comparison and multiple contrast indicators. Comparisons are

 determined by data dimensions, such as area and product type. Contrast indicators are 

determined by data measures, such as order quantity and order amount.
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Note

For each tornado chart, one and only one dimension must be specified to determine the 

comparison. At least one measure must be specified to determine contrast indicators.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities, profits, and average profits of different types of 

products.

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the tornado chart icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measures.

In the Dimensions list, select Product_type and add it to Comparison. In the Measures list,

select order_number, profit_amt, and average_profit, and add them sequentially to contrast

indicator, as shown in the following figure:

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title and layout of the diagram and hide the conversion

rate.

• tornado charts offer two types of layouts. You can also change the layout based on your 

habits.

• You can also change the position of the legend, adjust the color scheme of the diagram, and

 hide the conversion rates.

8. Click the Save icon to save the dashboard.

To delete the diagram, move the mouse to the upper-right corner and click Delete in the toolbar

that appears.

3.6.18 Hierarchy chart
This section describes how to create a hierarchy. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A hierarchy uses the tree structure to display and organize hierarchical data. It is an implementa

tion of the enumeration method. For example, when reviewing the revenues of the prefecture-
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level cities in one province, the relationships between the province and prefecture-level cities can

 be displayed as parent-child structures. Hierarchys are used for analyzing hierarchical data and 

creating staff organization charts and department organization charts.

A hierarchy contains a sequence of nodes with different labels and metrics. Each node label is 

determined by data dimensions, such as area and product type. Each node metric is determined 

by data measures, such as order quantity and order amount.

Note

For each hierarchy, at least two dimensions must be specified to determine node labels. These 

two dimensions should have a parent-child relationship. At least one measure must be specified to

 determine the node metric.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order quantities of different products across provinces and areas

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the hierarchy icon and the corresponding information is displayed.

5. Click the Data tab to select data dimensions and data measure.

In the Dimensions list, select Area, Province, and Product Type, and add them sequentially

to Node Label. This order determines their hierarchical relationships in the diagram. In the

Measures list, select Order Quantity and add it to Node Metric, as shown in the following

figure:

Note:

Make sure you have changed the data type of Area and Province from String to Location.

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title, layout, and design of the diagram.

• Hierarchys support three types of layouts. You can also change the style of tree nodes 

based on your habits. The root nodes are merged together by default.

• You can edit the levels of hierarchy in the menu bar and manually enter the number of 

levels. You can specify a primary path based on the field information so that the primary 
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path has a different color to other paths. You can also add a toolbar to the diagram so that 

you can easily edit the diagram in preview or through the dashboard.

8. Click the Save icon to save the dashboard.

To delete the diagram, move the mouse to the upper-right corner and click Delete in the toolbar

that appears.

3.6.19 Conversion path
This section describes how to create a conversion path. For more information, see #unique_50

and #unique_46. If you need to edit or create datasets, see Create a dataset.

A conversion path uses metrics such as page visits, page views (PVs) and unique visitors (UVs) to

 calculate the conversion rates on your website. This helps you understand the overall performanc

e of marketing campaigns and measure the sales volume of certain products. Conversion paths 

are suitable for analyzing digital marketing campaigns and e-commerce websites. For example, 

you can use conversion paths to find out which products are in great demand and what are the 

peak hours of your business.

Currently, conversion paths support the following three dimensions: previous page, current page

, and next page, and include the following measures: PV, UV, conversion rate, and bounce rate. 

You need to specify the PVs or UVs for all three pages.

Note

For each conversion path, one and only one dimension must be specified for each of the three

 pages. The dimensions must have hierarchical relationship. The order of the dimensions 

determines the hierarchical relationship in the diagram. One and only one measure must be 

specified for each of the three PVs or UVs, the conversion rate, and the bounce rate.

The three dimensions, the conversion rate, and the bounce rate are required fields. You can 

choose to specify only the PVs or UVs for all three pages. Error messages are shown if fields are 

incorrectly specified when adding the dimensions and measures.

The following uses the page_source_target_state dataset as an example.

Scenario: Use PVs to demonstrate the conversion and bounce rates on different pages

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the page_source_target_state dataset and click Create Dashboard.



Quick BI User Guide /  3 Create a report

Issue: 20181217 81

4. Click the Conversion Path icon and the corresponding legend is displayed.

5. Click the Data tab to select data dimensions and data measures.

In the Dimensions list, select the Previous Page, Current Page, and Next Page, and add

them to the corresponding fields. This order determines the hierarchical relationship between

pages in the diagram. In the Measures list, select the Conversion Rate and Bounce Rate,

and add them to the corresponding fileds. You also need to select three PVs or UVs for the

corresponding pages.

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title and layout of the diagram.

The conversion path provides three layouts and allows you to highlight the main path or popup

 windows.

8. Click the Save icon to save the diagram.

To delete the diagram, move the mouse to the upper-right corner and click Delete in the toolbar

that appears.

3.6.20 LBS thermal map

Note:

LBS thermal maps are only available to Quick BI Pro users.

This section describes how to create an LBS thermal map. For more information, see #unique_50

and #unique_46. If you need to edit or create datasets, see Create a dataset.

Similar to #unique_89, LBS thermal maps use the gradation of color to reflect data distribution

across regions.

An LBS thermal map consists of geographic regions with different colors. Regions are determined

 by data dimensions, or the latitude and longitude values of the location, such as province. Colors 

are determined by data measures, such as order amount and profits.

Note

For each LBS thermal map, one and only one dimension must be specified to determine the 

regions. This dimension must be about geographic information. One to five measures can be 

specified to determine the colors of regions.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the transportation costs and order quantities across provinces
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1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

Note:

If you are using the Professional edition, you need to select between the Standand Mode

and Full Screen Mode. The following example uses the Standard Mode.

4. Click the LBS thermal map icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and measures.

In the Dimensions list, select province and add it to Geographical area/Latitude and longitude.

In the Measures list, select order_amt and shipping_cost, and add them to LBS Thermal

depth, as shown in the following figure:

Note:

Make sure you have changed the data type of Province from String to Location.

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title and layout of the diagram and the style of specific

fields.

• In the Layout section, you can set the basemap to Google Maps and the updated diagram

is as follows:

8. Click the Save icon to save the dashboard.

In the upper right corner, selectMore > > Deleteto delete the diagram.

For more information about the administrative regions of China, see Administrative regions of 

China.

3.6.21 LBS bubble map

Note:

http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/48322/cn_zh/1534241743586/%E5%90%84%E5%9C%B0%E5%8C%BA%E8%AF%A6%E7%BB%86%E4%BF%A1%E6%81%AF%E5%AF%B9%E7%85%A7%E8%A1%A8.xls
http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/48322/cn_zh/1534241743586/%E5%90%84%E5%9C%B0%E5%8C%BA%E8%AF%A6%E7%BB%86%E4%BF%A1%E6%81%AF%E5%AF%B9%E7%85%A7%E8%A1%A8.xls
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LBS bubble map is only applied to Quick BI Professional Edition.

This section describes how to create an LBS bubble map. For more information, see #unique_50

and #unique_46. If you need to edit or create datasets, see Create a dataset.

Similar to #unique_74, an LBS bubble map is a map that uses the sizes of bubbles distributed

across the map to reflect data. It provides multiple basemaps for you to choose from, such as

AMAP, Google Maps, and GeoQ. LBS bubble maps allow you to understand the distribution

and values of metrics across countries and regions in an easy and visual way. For example,

LBS bubble maps can display the passenger numbers across tourist attractions or the per capita

incomes across regions.

An LBS bubble map consists of geographic regions with bubbles of varying sizes. Regions are

 determined by data dimensions, such as province. LBS bubble sizes are determined by data 

measures, such as transportation cost and order quantity.

Note

For each LBS bubble map, you must only specify one dimension to determine the regions. This

 dimension must be about geographic information, such as area, province, and city. One to five 

measures can be specified to determine LBS bubble sizes.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare the order amounts and profit amounts across provinces

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

Note:

If you are using the Professional edition, you need to select between the Standand Mode

and Full Screen Mode. The following example uses the Standard Mode.

4. Click the LBS Bubble Map icon and the corresponding legend is displayed.

5. Click the Data tab to select the data dimension and data measures.

In the Dimensions list, select province and add it to Location. In the Measures list, select

order_number and profit_amt, and add them to LBS bubble size, as shown in the following

figure:
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6. Click Update to generate the diagram.

7. In the Style tab, you can change the title and layout of the diagram and the style of specific

fields.

• In the Layout section, you can change the basemap, resize the map, and adjust the

coordinates of the longitude and latitude. For example, when the basemap is set to GeoQ,

the updated diagram is as follows:

• In the Series Settings section, you can change the number of decimal places of order

amounts to 2. The updated diagram is as follows:

8. Click the Save icon to save the dashboard.

In the upper-right corner, selectMore > > Deleteto delete the diagram.

3.6.22 LBS flying line map

Note:

LBS flying line map is only applied to Quick BI Professional Edition.

This section describes how to create an LBS flying line map. For more information, see

Dashboard overview and #unique_46. If you need to edit or create datasets, see Create a dataset.

An LBS flying line map is a map that uses LBS flying line metrics to display the relations between 

data across two or more geographic regions.

An LBS flying line map consists of geographic regions connected with LBS flying line metrics. 

Regions are determined by data dimensions, such as province and city. LBS flying line metrics are

 determined by data measures, such as transportation cost and order quantity.

Note

For each LBS flying line map, two dimensions must be specified to determine regions. This 

dimension must be about geographic information, such as area, province, and city. One and only 

one measure must be specified to determine LBS flying line metrics.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Display the costs of transportation from areas to provinces
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1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

Note:

If you are using the Pro edition, you need to select between the Standand Mode and Full

Screen Mode. The following example uses the Standard Mode.

4. Click the LBS flying line map icon and the corresponding legend is displayed.

5. Click the Data tab to select data dimensions and data measure.

In the Dimensions list, select area and add it to Geographic area/Latitude and longitude (from).

Select province and add it to Geographical area/Latitude and longitude (to). In the Measures

list, select shipping_cost and add it to LBS flying line metric, as shown in the following figure:

Note:

Make sure you have changed the data type of Area and Province from String to Location.

6. Click Update to generate the diagram.

7. In the Style tab, you can change the title and layout of the diagram, and change series settings

as follows:

In the Layout section, you can set the basemap to AMAP and move the Legend to the bottom

of the map. The updated diagram is as follows:

Note:

A dot is moving along each LBS flying line metric to indicate the direction of traffic. You can

set Time to adjust its speed. A greater value indicates a lower speed.

8. Click the Save icon to save the dashboard.

To delete the diagram, move the mouse to the upper-right corner and click More > Delete in

the toolbar that appears.
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3.6.23 Pivot table

Note:

Pivot tables are only applied to Quick BI Professional Edition.

This section describes how to create a pivot table. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A pivot table can be used to display the summary statistics of variables and allows you to drill into

 data in a tree structure. One variable defines the values in the header row and the other variable

 defines the values in the header column. The intersections of rows and columns contain the 

results of calculations on the data, such as the sum, average, maximum, minimum, or count of the

 data.

Similar to #unique_94, a pivot table consists of rows and columns. Rows are determined by data

dimensions, such as province and product type. Columns are determined by data measures, such

as order quantity and profit amount.

Note

For each pivot table, the numbers of dimensions and measures are unlimited.

The following scenario uses the company_sales_record dataset as an example.

Scenario: Compare multiple types of products with different package designs, order 

quantities, and order amounts across multiple provinces

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

• If you are using the Professional Edition, you need to select between the Standand Mode

and Full Screen Mode. The following scenario uses the Standard Mode as an example.

4. Click the Pivot Table icon and the corresponding legend is displayed.

5. Click the Data tab to select data dimensions and data measures.

In the Dimensions list, select province, product_type, and product_box, and add them

sequentially to Row. In the Measures list, select order_number and order_amt, and add them

sequentially to Column, as shown in the following figure:

Note:
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Make sure you have changed the data type of Province from String to Location.

6. Click Update to generate the table.

7. In the Style tab, you can change the title, layout, and style of the table as follows:

• In the Layout section, select Show Row Numbers and Add Summary Statistics. The

updated table is as follows:

• In the Set Format section, set the number of decimal places of order_amt to 1. The

updated table is as follows:

8. Click the Plus sign ahead of a value to drill into the data in a tree structure.

For example, when you click the plus sign ahead of Shanghai, data about product types and

packet designs are displayed in a tree structure.

9. Click the Save icon to save the dashboard.

In the upper-right corner, select More > Delete to delete the table.

3.6.24 Progress bar
This section describes how to create a progress bar. For more information, see #unique_50 and

#unique_46. If you need to edit or create datasets, see Create a dataset.

A progress bar displays the progress of the current task.

A progress bar consists of multiple progress metrics. Progress metrics are determined by data 

measures, such as order quantity.

Note

• For each progress bar, one to five measures can be specified to determine the progress 

metrics.

• To use progress bars, you need to click Style > Series Setting to specify the maximum and

minimum values of progress metrics.
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The following scenario uses the company_sales_record dataset as an example.

Scenario: Use a progress bar to display the order quantity

1. Log on to the Quick BI console.

2. Click Datasets to open the dataset management page.

3. Select the company_sales_record dataset and click Create Dashboard.

4. Click the Progress bar icon and the corresponding legend is displayed.

5. Click the Data tab to select data measures.

In the Measures list, select order_number and add it to Progress indicator/Measure, as shown

in the following figure:

6. Click Update to generate the chart.

7. In the Style tab, you can change the title and legend of the diagram, and set an alias for the

metric, as follows.

8. Click the Save icon to save the dashboard.

To delete the chart, move the mouse to the upper-right corner and click Delete in the toolbar that

appears.
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